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Guide Purpose 

The purpose of this guide is to provide Poster Presenters with important information to 

consider when developing their poster presentation for the ASHE 2020 Virtual 

Conference. 

 

We want to share that this is ASHE’s first ever virtual conference. We have been 

working on this conference since June of 2019 and shifted to the virtual format in July 

2020. We’ve poured much time and attention into these resources; however, it is 

possible (and perhaps likely) that we missed something or something is not as clear as 

it could be. We hope you will reach out to ASHE Conference Coordinator James Hines 

at james@ashe.ws with any questions, comments, or concerns. This will help us ensure 

the resources we provide to you and your fellow ASHE members are as inclusive as 

possible. 
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Land Acknowledgement 

Although we may be joining each other virtually throughout ASHE 2020, we are also 

able to do so grounded by diverse lands, each with their own names, histories, and 

relationships. While COVID has called us to limit our travel and social interactions in 

efforts to curb the spread of the disease and protect our communities, we hope that it 

also provides us with time to reflect on the lands where we live and work as well as on 

the relationships that we have or aspire to build with them. Such reflection can provide a 

vital first step to the work of decolonization, work which must go hand in hand with the 

dismantling of entrenched racial inequities. 

  

This year, we invite all presenters, chairs, and discussants to engage in land 

acknowledgement when participating in ASHE 2020 events and sessions. We 

encourage members and invited speakers to share brief remarks grounded by their own 

respective locations to begin their presentations. We hope that the ASHE membership 

will welcome this opportunity to share the labor that is too-often solely shouldered by the 

Indigenous members of our community. While the actual content of a land 

acknowledgment may be relatively brief, what is equally important is the work that goes 

on behind the scenes--the processes of research, learning, and reflection.  

While there are multiple forms that land acknowledgements can take, here is one 

example from the NCORE Conference: 

This land on which I / we inhabit is physically situated in the original ancestral 

homelands of the << LOCAL TRIBE NAME(S) >>. We pay respect to the << TRIBE 

NAME(S) >> peoples – past, present, and future – and their continuing presence in the 

homeland and throughout their historical diaspora. 

 

As members begin to engage in land acknowledgements, one resource that may be 

used to identify the Indigenous tribes and peoples of an area is http://native-land.ca. 

From there, we recommend searching for and exploring the websites of Indigenous 

nations and community organizations to learn more. For additional resources, insight, 

and guidance on land acknowledgment, see 

https://www.ashe.ws/landacknowledgements which was drafted by the ASHE Land 

Acknowledgment Working Group. 

 

Finally, we would like to take the time to recognize the original intended location of 

ASHE 2020. The land currently known as New Orleans is physically situated in the 

region known as “Bulbancha,” a Choctaw term meaning “place of many tongues.” This 

place was originally inhabited by the Chitimacha nation and, prior to 1718, served as an 

important port and trading hub for more than 40 diverse peoples, including Atakapa, 

Caddo, Choctaw, Houma, Natchez, and Tunica nations. We pay respect to these 

http://native-land.ca/
https://www.ashe.ws/landacknowledgements
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communities, and look forward to gathering in Bulbancha for the ASHE 2024 

conference. 



5 

Presenter Agreement 

By presenting at the ASHE Annual Conference, you agree to the following Virtual 

Presenter Agreement: 

● My presentation is based on original work that has not been published in any venue, 

online or print, or presented at other conferences. 

● For papers, posters, or roundtables: At least one of author/co-author will present the 

work on the day and time designated. 

● All presenters, chairs, and discussants must be registered for the ASHE Conference 

and/or respective Pre-Conference by October 15, 2020; this ensures you will receive 

your individual presenter link prior to the conference. 

● I grant ASHE the right and permission to stream live and record my presentation(s) 

as part of the annual conference. This material will be available to conference 

registrants, members, and the ASHE community during and immediately after the 

conference for educational purposes consistent with the mission of the association. I 

relinquish the right to examine or approve the audio or video recordings before 

publication, including any print materials in connection with audio and video 

recordings. I agree no royalties are due to me. 

● I acknowledge that I have read this consent and release prior to agreeing to it and 

that I understand its content. I understand that the ASHE is relying on this 

agreement and release and that my release and consent or irrevocable. 

● If you do not agree to these items, please email conference@ashe.ws. Please 

include your name, session title, and what parts of the presenter agreement you do 

not agree to; please note this may prevent ASHE from allowing you to present 

during the annual conference. 
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Event Code Of Conduct 

We realize that the shift from in-person events (including but not limited to the general 

conference, pre-conference forums, professional development events) to virtual events 

means there may be some questions about acceptable behavior. As such, the ASHE 

Board of Directors has adopted a Virtual Code of Conduct, which provides specific 

(albeit not exhaustive) examples.  

 

ASHE Virtual Code Of Conduct  

Approved by the ASHE Board of Directors, July 29, 2020 

 

Scope: This policy applies to all virtual ASHE events, synchronous and asynchronous. 

 

ASHE is committed to providing a safe, productive, and welcoming environment for 

event participants. Participants, including, but not limited to, attendees, speakers, 

volunteers, exhibitors, staff members, service providers, and all others are expected to 

abide by this Virtual Code of Conduct as well as ASHE Ethical Principles 

(https://www.ashe.ws/content.asp?admin=Y&contentid=158) and ASHE Code of Ethics 

(https://ashe.membershipsoftware.org/files/ASHE%20Policies/ASHE%20CODE%20OF

%20ETHICS%20FINAL%202015.pdf).  

 

As is commonplace in academic discourse and professional associations, participants 

are welcome and encouraged to express an opinion, raise research, or describe an 

experience that may differ from others if it is part of an on-point discussion of the topic 

at hand and is offered in a manner that does not interfere with others’ reasonable ability 

to participate fully. However, participants should refrain from engaging in unacceptable 

behavior. Though it is not possible to list all forms of behavior that are unacceptable in 

an academic association’s professional settings, participants should generally avoid 

expressions or conduct that either intends to or results in harm to another and takes 

place without scholarly justification, including (but not limited to) harassment, theft of 

intellectual property, and unapproved promotions.   

 

ASHE has zero-tolerance for any form of discrimination, harassment, or intimidation of 

any form, including but not limited to sexual harassment by participants. Examples of 

these include, but are not limited to, comments related to gender, sexual orientation, 

disability, physical appearance, body size, race, religion, national origin; inappropriate 

use of nudity and/or sexual images in public spaces or in presentations; or threatening 

or stalking. This also includes the disruption of presentations/presenters as well as 

taking screenshots of participants and/or any chat room activity without consent.  

 

ASHE also wants to protect members from theft of intellectual property and/or the 

https://www.ashe.ws/content.asp?admin=Y&contentid=158
https://ashe.membershipsoftware.org/files/ASHE%20Policies/ASHE%20CODE%20OF%20ETHICS%20FINAL%202015.pdf
https://ashe.membershipsoftware.org/files/ASHE%20Policies/ASHE%20CODE%20OF%20ETHICS%20FINAL%202015.pdf
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dissemination of papers, comments, or ideas without the consent of authors/presenters. 

Participants should not record or live stream presentations and discussions that occur 

during events; nor copy or take screenshots of presentation materials unless explicit 

(and ideally written) permission is granted by the presenter/author. If something being 

presented is of interest to you, we suggest contacting the presenter directly, either via 

the chat or Q&A function or via email after the presentation. 

Finally, events should not be used for purposes other than which they were intended. 

Participants should not promote products or services, special offers, job offers, product 

announcements, or solicit for services during events unless expressly approved by 

ASHE in writing.  

 

For most events, an ASHE Conference Staff member will be in attendance to support 

presenters and attendees in upholding these guidelines. If you experience any incidents 

of unacceptable behavior, you can private message the ASHE Conference Staff and/or 

inform ASHE Conference Coordinator James Hines at james@ashe.ws or ASHE 

Executive Director Dr. Jason P. Guilbeau at jason@ashe.ws or (702) 895-2737.  

 

All participants must comply with the instructions of the event moderator and any ASHE 

Event Staff. Appeals to decisions can be directed to ASHE Executive Director Dr. Jason 

P. Guilbeau at jason@ashe.ws. 

 

In the interest of providing a safe, productive, and welcoming environment, ASHE 

Conference Staff reserve the right to take any action deemed necessary and 

appropriate, including immediate removal from the event without warning or refund, in 

response to any incident of unacceptable behavior. 
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Registration 

Poster authors must be registered for the conference by the regular registration 

deadline on October 15 to ensure their participation. 

 

Registered presenters will receive an Attendee email with login information to access 

the conference a few days before the event. 
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Uploading Your Poster Information 

To create your Poster Presentation Space, the ASHE Conference Coordinator will email 

the proposal submitter a Poster Presentation Form to complete. This form needs to be 

completed by October 26 at 4:00pm Pacific. 

 

Note: Prior to developing your poster presentation materials, please read all 

accessibility recommendations provided on the ASHE Website to ensure your 

presentation is accessible for all Attendees: https://www.ashe.ws/accessibility2020  

 

Poster Presentation Components 

The following information is needed to create your Poster Presentation for the Virtual 

Conference: 

● Poster: PDF File created from PowerPoint. PowerPoint is the suggested format as it 

is traditionally the easiest to transition to a PDF and has the “Check Accessibility” 

feature to receive feedback about your Poster. To Click the “Check Accessibility” 

feature under the “Review” tab to receive feedback on your Poster Presentation 

● 2-3 Minute Presentation Video: attach mpeg-4 video file created from PowerPoint. 

Example Outline: 

o 30 Seconds Introduction and Land Acknowledgement 

o 30 Seconds Literature Review 

o 30 Seconds Methods  

o 30 Seconds Results 

o 30 Seconds Implications 

● Handout/Resource: A one-page resource PDF. 

https://www.ashe.ws/accessibility2020
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Creating your Poster 
 
Recommended content for your poster 

● A clear statement of the purpose or goals of the research (i.e., the primary research 
questions or issues being addressed) 

● A brief summary of the theoretical or conceptual foundation for the work 
● A description of the methodology being used and the project findings (if applicable), 

and the theoretical and/or practical significance and implications of the research.  
● Use headers on your poster. Make sure your headers are clean and clear cut. 
● Consider using columns rather than rows for displaying content and arrange them in 

boxes. 
● Do not use colors that are bright, as they may not be accessible for seeing impaired 

individuals. 
● Consider utilizing size 28-32 size fonts. Headings of at least 48-point font and text at 

least 18-point font is helpful to readers.  
● Keep figures and tables as simple as possible. Five to seven figures is acceptable. 
● If you provide illustrations, brief large type heading of no more than one or two lines 

should be provided above each illustration. However, it is best to limit text. 
● A well-done poster should provoke interest and questions rather than overwhelm 

with text. 
 
Poster Creation Tips 

● Posters should be informative and graphically appealing. 

● Divide the content into sections. Clearly detail the project’s topic, thesis, scope, 

methodology, results, and conclusions. 

● Include: presenter name(s), co-authors, academic program, faculty advisor(s), and 

project title. 

● Maintain good contrast between the background color and the text color. For 

example a light gray background and black text or a dark navy blue background with 

light blue or white text. Colors should be consistent throughout the poster and 

readability should be the top priority.  

● Whenever possible use graphics to represent information.  

● When necessary, don’t forget to caption images, tables, etc. for clarity. 

● Use a font that is cross-platform to ensure that your poster retains the text, spacing, 

and look you want. Examples include: Calibri, Arial, and Times New Roman  

● Sans-serif fonts are recommended for posters, particularly for the title, subtitle, and 

headers. 

● Presenters must upload Posters in PDF format to ensure Attendees may access 

your poster from different devices and platforms.   

● Rule of thumb for font sizes: Use 20pt + font size for most text in the Poster 

● Carefully proofread your Poster 
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Creating Your Poster in PowerPoint (Recommended) 

We recommend the following steps to create your Poster in PowerPoint: 

1. Open a new presentation 

2. Delete all information on the slide 

3. Select the “Design” tab 

4. Select “Slide Size” and “Custom Slide Size”  

5. Select “Landscape” Orientation 

6. Input the recommended size for creating a virtual research poster, which is 48 

inches wide x 36 inches height 

7. Select “Maximize” 

8. Select your background color by right clicking the mouse and selecting “Format 

Background”. Select a background color that will allow for a good contrast between 

the text. If your content will be light, choose a dark background. If your  content will 

be dark, choose a light background color. Selecting “Solid fill” and using one color 

scheme of background and text colors is typically easier to format compared to using 

pictures or Gradient fill options.  

9. To insert text, click the “Insert” tab and then select “Text Box” 

10. With the cursor, draw a box on the screen with the upper-left corner placed where 

you want your text to begin. 

11. Begin typing your text 

12. After typing a few lines grab the “handlebars” on the right side of the text box and 

bring it to your preferred width. 

13. It is good practice to save the Poster Presentation often. Select the “File” tab, click 

“Save As”, select a location, Name the poster presentation, and click save. You can 

use Ctrl + S or the Save icon above “Insert” to save the changes moving forward.  

14. If you are copying text from a Word document, select the text from the menu of Ctrl-

C on your keyboard. 

15. Create a new textbox by following steps 9-10, left click on the text box and right click 

to generate the options for pasting the text 

16. Select “Use Destination Theme” or “Keep Text Only” to paste the information 

17. It is recommended to use a small number of fonts to keep the poster cohesive, and 

use various versions of the same font or colors to add desired variety 

18. To help with layout of headers and content, especially with paragraph formatting, 

press the VIEW tab and turn on the Ruler. You may also want to turn on Guides and 

even Gridlines if you think they are helpful.  

19. While working on your poster you will want to zoom in on the areas you are doing 

detailed work such as: Aligning text boxes, images, charts, etc. 

20. Use the “Arrange” functions under the “Home” tab to assist in lining objects up.  



12 

21. Pay special attention to the Align functions, click on all the objects you want to line 

up and select which alignment you want to do. Take some time to play with it; you 

can always undo (Ctrl-Z) if you make a mistake. 

22. If you have multiple objects that you want to move together, select all of the objects 

and select Arrange > Group. If you wish to ungroup at any time, you can select 

Ungroup. Grouped objects can also be edited separately if you add an extra click 

when selecting.  

23. Be sure to also zoom out to view the entire poster occasionally so you can keep an 

eye on the overall layout. You can Zoom out by using the minus symbol at the 

bottom right 

24. To insert an image, under the “INSERT” tab, click Pictures 

25. Right-clicking on the image brings up some options, including a crop tool. Crop 

marks appear, which can be moved to show the portion of the image you wish to 

keep. 

26. Resize images by grabbing a corner handle of the image. Try to use the highest-

resolution image you can.  

27. To add a Chart, go to the “INSERT” tab and select “Chart”. This will bring up several 

different types of charts. You can select the one that meets your needs. After 

selecting one, press “OK”. 

28. A default chart will be inserted into the PowerPoint slides with a spreadsheet. You 

can either manually replace the pre-formatted spreadsheet data or copy and paste 

information from another external spreadsheet. 

29. Proofread your poster to check for formatting adjustments, grammatical errors, and 

spacing issues. Remember the top priority for Poster presentations is readability for 

conference attendees. 
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Creating your Poster Video 
Poster presenters will also record a 2-3 minute presentation video which will be 

uploaded to the Virtual Conference.  

 

The following steps are for people using the Windows platform. PowerPoint does not 

allow webcam use during recording for Mac users. Additional suggestions for recording 

your poster presentation videos are included on the next page.  

We recommend recording over your poster you created in PowerPoint: 

1. Click the “Slide Show” tab  

2. Click the “Record Slide Show” under the “Slide Show” tab 

3. Click “Settings” and select the microphone and camera you want to use to record the 

video 

4. The window containing the camera feed will pop up in the lower right corner of the 

screen 

5. The Record button is located in the upper left corner of the window. Click on it to 

start recording the presentation 

6. Begin your video with an Introduction and Land Acknowledgement, 

7. Record your video. 

● Make sure you are recording in an area with minimal distractions 

● PowerPoint records the presentation that is displayed on the screen as well as 

the video and audio that is picked by the microphone and camera  

● Annotation tools are below the poster slide, which enables you to draw the 

viewer’s attention to areas of the poster during the presentation 

8. Click on the Stop button when you are done presenting and head back to the 

PowerPoint’s main window 

9. The video you recorded will be embedded in the Poster slide used during the 

recording session.  

10. To save your recorded Poster Presentation in PowerPoint: 

11. Click the “File” tab 

12. Click the “Export” option 

13. Select “Create a Video”  

14. Select the 1080p (default) option  

15. Click “Create a Video” option 

16. Use the Title of your Poster as the “File Name” 

17. Select the location you want to save the video  

18. Select mpeg-4 as the “Save as type” 

19. Review the saved file to make sure the presentation is correct 

20. Upload the Video to the Poster Presentation Form you receive from the ASHE Office 

 

Note: The Poster video can also be recorded outside of PowerPoint, but will need to be 

saved as an mpeg-4 to attach to the Poster Presentation Form 



14 

Creating your Poster Video (Mac Users) 
 
Users of Mac computers are not able to use their webcam when recording on 
PowerPoint. For Mac users we recommend using Zoom to record your 2-3 minute 
presentation video. Below we have provided steps to assist in this process. 
 

1. Log in to Zoom or Create a Zoom Account https://zoom.us/signin 
2. Download Zoom to your Mac: https://zoom.us/support/download 
3. Open your Poster so that is visible on your desktop (e.g., PowerPoint, Pdf, etc.) 
4. Once Zoom is installed on your Mac and open Zoom 
5. Log in to your Zoom Account 
6. Select “New Meeting” 
7. Select “Join with Computer Audio” 
8. Select “Share Screen” and the option that displays your Poster (e.g., PowerPoint 

or Pdf) 
9. After you have selected the Poster, click “Share” 

a. If you are sharing a PowerPoint, select the “Slide Show” tab and click 
“From Beginning” or “From Current Slide” 

b. If you are sharing a Pdf, make sure all the content is visible 
10. Move the video window so that you are visible but not blocking the poster 

information 
a. You can move the video window by clicking and dragging the video 

window 
b. You can resize the video window by dragging from the edges of the video 

window 
11. Hover over the green “You are screen sharing” message and select the “More” 

Option 
12. Select “Record on this Computer” to start a recording that will save as an mp4 

Format on your computer 
13. Conduct your 2-3 minute presentation  
14. Once you have finished your presentation, click the red “Stop Share” button 
15. Click “Stop Recording” at the bottom of the screen 
16. The mp4 file of the recording will be created once you end the meeting 
17. To end the meeting, click the red “End” button 
18. Click “End Meeting for All” 
19. Once the recording has finished converting to the mp4 file format, click the mp4 

file from the popup folder to review the recording 
20. If you need to re-record, you can then follow the previous steps to record the 

presentation again, or edit the video using additional software. 
21. Once you are satisfied with the recording, rename the file the title of your ASHE 

Poster Presentation. 
22. Save the mp4 recording file in a place that you can easily find it. 
23. Upload the mp4 recording file to the poster form you received from the ASHE 

Office.  
 

 

https://zoom.us/signin
https://zoom.us/support/download
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Poster Handout/Resource 
For the in-person conference, we typically encourage poster presenters to have a one-

page handout with additional resources, your contact information, etc. 

 

For the Virtual Conference, you can do the same. We welcome you to also upload a 

one-page PDF handout. This may include highlights from your presentations, citations, 

additional figures, etc.
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How To View Your Poster (beginning November 9) 

Once you have successfully logged into the Virtual Conference as an Attendee, you can 

view your poster presentation materials: 

1. Click on the Poster Gallery tab to see the list of poster presentations 

2. Scroll and click on the title of the poster to view your submitted poster materials.  

 

Feedback on your Poster (beginning November 9) 

Within each Poster contains an email option that allows attendees to send direct email 

messages to the author(s) about their presentation. Poster Authors should expect to 

receive communication about their presentation from attendees between November 9 to 

November 30. 

 

NOTE: Poster presenters will only be able to interact with attendees that use the direct 

email feature.  

 


